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Frontispiece 1. Tentative correlation of color
reflectance records at Sites 1091, 1093, and
1094 with a benthic oxygen isotopic record
from Site 846 for marine isotope Stages (MISs)
8 through 12 (Mix et al., 19951). High
reflectance values represent peak interglacial
stages when sediments contain a high
proportion of CaCO3. The high sedimentation
rates at these Leg 177 sites, located on a north-
south transect across the Antarctic Circumpolar
Current, permit paleoceanographic studies at
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millennial scale or better resolution. In most
sites, MIS 11 stands out as the brightest, most
carbonate-rich sediments of the Pleistocene. At
Site 1093, Termination V (MIS 12–11
transition) is represented by an 8-m expanded
section (from ~133 to 125 meters composite
depth [mcd]) that contains a thick laminated
interval of Thalassiothrix diatom mats (see
corresponding core photograph of the section
enclosed by the box in the reflectance record
of Site 1093).
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1Mix, A.C., Le, J., and Shackleton, N.J., 1995. Benthic foraminiferal stable isotope stratigraphy of Site 846: 0–1.8 Ma. In
Pisias, N.G., Mayer, L.A., Janecek, T.R., Palmer-Julson, A., and van Andel, T.H. (Eds.), Proc. ODP, Sci. Results, 138: College
Station, TX (Ocean Drilling Program), 839–854.
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Frontispiece 2. Core 177-1093A-13H contains sediments
that represent the transition from MIS 12 to 11
(Termination V). The dark sediment in Sections 177-1093A-
13H-6, 13H-7, and 13H-CC corresponds to glacial MIS 12.
Sections 177-1093A-13H-2 (partim), 13H-3, 13H-4, and
13H-5 represent a thick laminated interval of Thalassiothrix

diatom mats that accumulated at high sedimentation rates,
offering an unprecedented opportunity to study
paleoceanographic changes in the Southern Ocean
associated with Termination V at high temporal resolution.
The white sediment in Section 177-1093A-13H-1 represents
MIS 11.
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Effective publication dates of ODP Proceedings

According to the International Code of Zoological Nomenclature, the date of publication of a work 
and of a contained name or statement affecting nomenclature is the date on which the publication 
was mailed to subscribers, placed on sale, or when the whole edition is distributed free of charge, 
mailed to institutions and individuals to whom free copies are distributed. The mailing date, not the 

printing date, is the correct one.

The printing date of this volume: April 1999

The mailing dates of recent Proceedings of the Ocean Drilling Program:
Volume 173 (Initial Reports): July 1998
Volumes 174A/174AX/174B (Initial Reports): November 1998
Volume 175 (Initial Reports): November 1998
Volumes 159/159T (Scientific Results): October 1998
Volume 160 (Scientific Results): September 1998
Volume 161 (Scientific Results): February 1999

Copies of this publication may be obtained from Publications Distribution Center, Ocean Drilling 
Program, Texas A&M University, 1000 Discovery Drive, College Station, TX 77845-9547, U.S.A. See 
the ODP publication list at www-odp.tamu.edu/publications or contact ODP for prices and ordering 
information. Orders for copies require advance payment.

http://www-odp.tamu.edu/publications
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PUBLISHER’S NOTES
This publication was prepared by the Ocean Drilling Program, Texas A&M University, as an account of 
work performed under the international Ocean Drilling Program, which is managed by Joint 
Oceanographic Institutions, Inc., under contract with the National Science Foundation. Funding for 

the program was provided by the following agencies at the time of this cruise:

Australia/Canada/Chinese Taipei/Korea Consortium for Ocean Drilling: Department of Primary Industries and 
Energy (Australia), Department of Energy, Mines and Resources (Canada), National Taiwan University in Taipei, 
and Korean Institute for Geology, Mining and Minerals

Deutsche Forschungsgemeinschaft (Federal Republic of Germany)

European Science Foundation Consortium for Ocean Drilling (Belgium, Denmark, Finland, Iceland, Italy, The 
Netherlands, Norway, Portugal, Spain, Sweden, Switzerland, and Turkey)

Institut Français de Recherche pour l’Exploitation de la Mer (France)

National Science Foundation (United States)

Natural Environment Research Council (United Kingdom)

University of Tokyo, Ocean Research Institute (Japan)

Any opinions, findings, and conclusions or recommendations expressed in this publication are those of 
the author(s) and do not necessarily reflect the views of the National Science Foundation, the 
participating agencies, Joint Oceanographic Institutions, Inc., Texas A&M University, or Texas A&M 
Research Foundation.
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Abbreviations for names of organizations and publications in ODP reference lists follow the style given 
in Chemical Abstracts Service Source Index (published by American Chemical Society).

The bulk of the shipboard-collected data from this leg is available on the World Wide Web and is 
accessible at www-odp.tamu.edu/database. If you cannot access this site or need additional data, 
please contact the ODP Data Librarian, Ocean Drilling Program, Texas A&M University, College 

Station, TX 77845-9547, U.S.A. (e-mail: database@odp.tamu.edu).

Supplemental data on the volume CD-ROM were provided by the authors and may not conform to 
ODP publication formats.

A site map showing the drilling locations for this leg and maps showing the drilling locations of all 
Ocean Drilling Program (ODP) and Deep Sea Drilling Project (DSDP) drilling sites are available on the 
volume CD in PDF format.

Beginning with Initial Reports Volume 176 and Scientific Results Volume 169, all Proceedings volumes 
will be published on CD-ROM and the World Wide Web at www-odp.tamu.edu/publications. 

Initial Reports Scientific Results
Booklet format: ISSN 0884-5883 Book: ISSN 0884-5891
CD-ROM format: ISSN 1096-2522 CD-ROM format: ISSN 1096-2514
WWW format: ISSN 1096-2158 WWW format: ISSN 1096-7451

Cover photograph of the JOIDES Resolution.

http://www-odp.tamu.edu/publications
http://www-odp.tamu.edu/database
mailto:database@odp.tamu.edu)
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FOREWORD

BY JOINT OCEANOGRAPHIC INSTITUTIONS, INC.

This volume presents scientific and engineering results from the Ocean Drilling Program (ODP). These results 

address the scientific and technical goals of the program, which are focused on the study of the dynamics of 
Earth’s interior and environment.

ODP, an international partnership of scientists and research institutions from 22 countries, operates the drillship 
JOIDES Resolution. This state-of-the-art research vessel contains seven levels of laboratories and other scientific 
facilities required for carrying out the program’s objectives.

The management of ODP involves a partnership of scientists and governments. International oversight and 
coordination are provided by the ODP Council, which is made up of representatives from the member 
countries. Overall scientific and management guidance is provided by representatives from the Joint 
Oceanographic Institutions for Deep Earth Sampling (JOIDES).

Joint Oceanographic Institutions, Inc. (JOI), a nonprofit consortium of eleven U.S. oceanographic institutions, 
serves as the National Science Foundation’s prime contractor for ODP. JOI implements scientific objectives, 
plans, and recommendations of the JOIDES committees through major subcontracts to Texas A&M University 
(TAMU) for science operations and to Lamont-Doherty Earth Observatory (LDEO) of Columbia University for 
logging services.

JOI, TAMU, and LDEO have worked together successfully for many years to manage the Ocean Drilling 
Program. We look forward to many exciting discoveries and continued international collaboration as we further 
our scientific mission, especially the planning for the future of ocean drilling beyond 2003.

James D. Watkins
Admiral, U.S. Navy (Retired)
President, Joint Oceanographic Institutions, Inc., Washington, D.C.
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l’Exploitation de la Mer

Japan, University of Tokyo, Ocean Research 
Institute

People’s Republic of China, Marine High-
Technology Bureau of the State Science and 
Technology Commission of the People’s 
Republic of China

United Kingdom, Natural Environment Research 
Council 

JOIDES Office
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Web site: www.joides.geomar.de

ODP PROGRAM MANAGER

Joint Oceanographic Institutions, Inc.
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Washington, DC 20036-2102, U.S.A.
Tel: (202) 232-3900; Fax: (202) 462-8754
E-mail: joi@brook.edu
Web site: www.joi-odp.org

http://www.oceandrilling.org
mailto:joides@geomar.de
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ODP SCIENCE OPERATOR

Ocean Drilling Program
Texas A&M University
1000 Discovery Drive
College Station, TX 77845-9547, U.S.A.

ODP SITE SURVEY DATA BANK

Lamont-Doherty Earth Observatory
Columbia University
P.O. Box 1000, Rt. 9W
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CD-ROM CONTENTS: CHAPTERS

1. Leg 177 Summary: Southern Ocean 
Paleoceanography
2. Explanatory Notes

3. Site 1088

4. Site 1089

5. Site 1090

6. Site 1091

7. Site 1092

8. Site 1093

9. Site 1094
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CD-ROM CONTENTS: CORE DESCRIPTIONS
Digital images and visual core descriptions (VCDs) are included in this section. VCDs and smear-slide 
data tables are combined into one PDF file for each site. Images can be accessed from the VCD pages. 
Smear-slide data tables in an ASCII format are also included on the ASCII TABLES page.
Site 1088

Visual Core Descriptions · Smear Slides

Site 1089

Visual Core Descriptions · Smear Slides

Site 1090

Visual Core Descriptions · Smear Slides

Site 1091

Visual Core Descriptions · Smear Slides

Site 1092

Visual Core Descriptions · Smear Slides

Site 1093

Visual Core Descriptions · Smear Slides

Site 1094

Visual Core Descriptions · Smear Slides



CD-ROM CONTENTS: ASCII TABLES

25

This CD-ROM contains ASCII versions of some of the data tables presented in the volume chapters 
and all of the smear-slide data tables presented in the Core Descriptions section. A complete listing 
of the ASCII data tables can be found on the next 5 pages. You can access these files directly from the 
PDF files. Depending on your computer platform, the following information applies.
Chapter 1
Chapter 2
Chapter 3

Chapter 4
Chapter 5
Chapter 6

Chapter 7
Chapter 8
Chapter 9

PC COMPUTERS
By default, clicking on a filename with a .TXT extension will launch the Notepad application. You can 
configure your computer’s operating system so that files on this CD with .TXT extensions 
automatically open in other software, such as Microsoft Excel. Follow these steps from the pull-down 
menu: Windows 95 and NT operating systems: View > Options > File Types; Windows 98 systems: 
View > Folder Options > File Types; and Windows 3.1 systems: File Manager > File > Associate.

MAC COMPUTERS
All table files with .TXT extensions will automatically open into Excel. If you do not have Excel installed 
on your computer, you may view these files through other spreadsheet or text-editor programs. Open 
the application of your choice, select File > Open, and open the ASCII file.

UNIX COMPUTERS

You can open files with .TXT extensions in any text editor or spreadsheet program, but not directly 
from PDF files.
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Chapter 1, Leg 177 summary
Table T2. Expanded coring summary for Site 1088. 
Table T3. Expanded coring summary for Site 1089. 
Table T4. Expanded coring summary for Site 1090. 
Table T5. Expanded coring summary for Site 1091. 

Table T6. Expanded coring summary for Site 1092. 
Table T7. Expanded coring summary for Site 1093. 
Table T8. Expanded coring summary for Site 1094. 

Chapter 2, Explanatory notes
Table T6. Control measurements of thermal conductivity in red rubber. 

Chapter 3, Site 1088
Table T1. X-ray diffraction data for Site 1088. 
Table T2. Composite depths for Site 1088. 
Table T3. Control points used to calculate sedimentation rates at Site 1088. 
Table T4. Summary of biostratigraphic age assignments for Holes 1088B and 1088C. 
Table T5. Distribution of main calcareous nannofossil species in Holes 1088B and 1088C. 
Table T6. Distribution of the main components of the planktic foraminifer assemblage in Holes 
1088B and 1088C. 

Table T7. Distribution of benthic foraminifers at Site 1088. 
Table T8. Diatom, silicoflagellate, ebridian, Actiniscus, sponge spicule, and opaline phytolith 
occurrence, Site 1088. 

Table T9. Distribution of main components of the radiolarian assemblage in Holes 1088B and 1088C. 
Table T14. Thermal conductivity measurements at Site 1088. 
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Chapter 4, Site 1089 
Table T1. X-ray diffraction data for Site 1089. 
Table T4. Composite depths for Site 1089. 
Table T5. Site 1089 splice tie points. 
Table T6. Distribution of main calcareous nannofossil species in Holes 1089A and 1089B. 
Table T7. Distribution of major planktic foraminifer species at Site 1089. 
Table T8. Distribution of benthic foraminifers in Holes 1089A and 1089B. 
Table T9. Control points used to calculate sedimentation rates for Holes 1089A, 1089B, 1089C, and 

1089D. 

Table T10. Diatom, silicoflagellate, ebridian, Actiniscus, sponge spicule, and opaline phytolith 
occurrence, Site 1089. 

Table T11. Summary of biostratigraphic age assignments for Holes 1089A, 1089B, 1089C, and 
1089D. 

Table T12. Distribution of the main components of the radiolarian assemblage at Site 1089. 
Table T18. Thermal conductivity measurements at Site 1089. 

Chapter 5, Site 1090 
Table T1. X-ray diffraction estimates of opal and terrigenous sediment abundances for Site 1090. 
Table T2. Composite depths for Site 1090. 
Table T3. Site 1090 splice tie points. 
Table T4. Distribution of main calcareous nannofossil species in Hole 1090B. 
Table T5. Summary of biostratigraphic age assignments for Site 1990. 
Table T6. Distribution of major planktic foraminifer species at Site 1090. 
Table T7. Distribution of benthic foraminifers in Hole 1990B. 
Table T8. Diatom, silicoflagellate, ebridian, Actiniscus, sponge spicule, and phytolith occurrence, Site 
1090. 

Table T9. Control points used to calculate sedimentation rates at Site 1090. 
Table T10. Main components of the radiolarian assemblage at Site 1090. 
Table T15. Thermal conductivity measurements at Site 1090. 
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Chapter 6, Site 1091
Table T1. X-ray diffraction data for Site 1091. 
Table T3. Composite depths for Site 1091. 
Table T4. Site 1091 splice tie points. 
Table T5. Distribution of main calcareous nannofossil species in Hole 1091A. 
Table T6. Summary of biostratigraphic age assignments for Site 1991. 

Table T7. Distribution of major planktic foraminifer species at Site 1091. 
Table T8. Distribution of benthic foraminifers at Site 1991.
Table T9. Diatom, silicoflagellate, ebridian, Actiniscus, sponge spicule, and phytolith occurrence, Site 
1091. 

Table T10. Control points used to calculate sedimentation rates at Site 1091. 
Table T11. Distribution of the main components of the radiolarian assemblages at Site 1091. 
Table T16. Thermal conductivity measurements at Site 1091. 

Chapter 7, Site 1092 
Table T1. X-ray diffraction data for Site 1092. 
Table T2. Composite depths for Site 1092. 
Table T3. Site 1092 splice tie points. 
Table T4. Distribution of main calcareous nannofossil species in Holes 1092A and 1092B. 
Table T5. Summary of biostratigraphic age assignments for Site 1092. 
Table T6. Distribution of major planktic foraminifer species at Site 1092. 
Table T7. Distribution of benthic foraminifers at Site 1092. 
Table T8. Diatom, silicoflagellate, ebridian, Actiniscus, sponge spicule, and phytolith occurrence, Site 
1092. 

Table T9. Control points used to calculate sedimentation rates at Site 1092. 
Table T10. Distribution of the main components of the radiolarian assemblages at Site 1092. 
Table T15. Thermal conductivity measurements at Site 1092. 
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Chapter 8, Site 1093
Table T2. X-ray diffraction data for Site 1093. 
Table T3. Composite depths for Site 1093. 
Table T4. Site 1093 splice tie points. 
Table T5. Distribution of main calcareous nannofossil species in Holes 1093A, 1093B, and 1093D. 
Table T6. Summary of biostratigraphic age assignments for Site 1993. 

Table T7. Distribution of major planktic foraminifer species at Site 1093. 
Table T8. Distribution of benthic foraminifers at Site 1093. 
Table T9. Control points used to calculate sedimentation rates at Site 1093. 
Table T10. Diatom, silicoflagellate, ebridian, Actiniscus, sponge spicule, and opaline phytolith 
occurrence, Site 1093. 

Table T11. Distribution of the main components of the radiolarian assemblage at Site 1093. 
Table T16. Thermal conductivity measurements at Site 1093. 

Chapter 9, Site 1094 
Table T2. X-ray diffraction data for Site 1094. 
Table T5. Composite depths for Site 1094. 
Table T6. Site 1094 splice tie points. 
Table T7. Distribution of main calcareous nannofossil species at Site 1094. 
Table T8. Summary of biostratigraphic age assignments for Site 1994. 
Table T9. Control points used to calculate sedimentation rates at Site 1094. 
Table T10. Distribution of major planktic foraminifer species at Site 1094. 
Table T11. Distribution of benthic foraminifers in Hole 1094A. 
Table T12. Diatom, silicoflagellate, ebridian, Actiniscus, sponge spicule, and phytolith occurrence, 
Site 1094. 

Table T13. Distribution of the main components of the radiolarian assemblages at Site 1094. 
Table T19. Thermal conductivity measurements at Site 1094. 
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Smear-Slide Data Tables 
Site 1088 smear-slide table. 
Site 1089 smear-slide table (part a). 
Site 1089 smear-slide table (part b). 
Site 1089 smear-slide table (part c). 

Site 1090 smear-slide table. 
Site 1091 smear-slide table. 
Site 1092 smear-slide table. 
Site 1093 smear-slide table. 
Site 1094 smear-slide table. 
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CD-ROM CONTENTS: SUPPLEMENTARY DATA

DRILLING LOCATIONS MAPS
A site map showing the drilling locations for this leg and maps showing the drilling locations of all 
Ocean Drilling Program (ODP) and Deep Sea Drilling Project (DSDP) drilling sites are available in PDF 
format.

ODP Leg 177 Site Map

ODP Map (Legs 100–177)

DSDP Map (Legs 1–96)
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RELATED CD-ROM MATERIAL

LOGGING, CORE, & COLOR REFLECTANCE DATA 
A second CD-ROM, called Log and Core Data, was produced in conjunction with this leg. The Log and 
Core Data CD contains Leg 177 depth-shifted and processed logging data and ODP core data 
(shipboard gamma-ray attenuation porosity evaluator, index properties, magnetic susceptibility, P-
wave, natural gamma, and color reflectance). The logging data are provided by the Borehole Research 
Group at the Lamont-Doherty Earth Observatory (LDEO), ODP Logging Services Operator for ODP. 
Also included on the LDEO CD are reflectance data collected during Leg 177 using the Oregon State 
University Split Core Analysis Track.

The majority of the data included in this CD are available on the World Wide Web at 
www.ldeo.columbia.edu/BRG/ODP. If you cannot access this site or want to order the CD, please 
contact the ODP Logging Services Operator at the Lamont-Doherty Earth Observatory; Tel: (914) 365-
8672; Fax: (914) 365-3182; E-mail: borehole@ldeo.columbia.edu.

http://www.ldeo.columbia.edu/BRG/ODP
mailto:borehole@ldeo.columbia.edu


33
CD-ROM DIRECTORY STRUCTURE
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Site 1088: VCD_1088.PDF

Site 1089: VCD_1089.PDF
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